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Welcome to the latest edition of my monthly Final Cut Studio newsletter for September, 2008.

The goal of this newsletter is to provide information helpful to the professional user 
of Final Cut Pro. This newsletter publishes each month. Past issues are archived 
at the end of each year with key articles posted on my website for your reference. 
All software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, the latest industry news, over 400 articles, and tutorials to help you 
get the most out of Final Cut!
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WRAP-UP

Welcome

Happy birthday to us! 

This issue marks the start of the fifth year I've been publishing this newsletter. It doesn't seem 
that long, somehow. Thanks for your interest - and for recommending this newsletter to your 
friends. Each issue is read by tens of thousands of editors all over the world.

Sigh... It seems like summer just started and already Labor Day is past. (For those of you outside 
the US, Labor Day is the first Monday in September and a US holiday.)

But, with the start of fall, we have a lot going on. Our PowerUP Seminar tour starts in a week, I 
am starting a new Blog, we have new training videos, and we have a ton of Final Cut Studio 
news and techniques to cover!

So let's get started!

[ Go to Top. ] 

Hard Disk Warning!

For those of you who are archiving your products on hard disks, please pay close attention!

Recently, I was talking to an engineering manager of a well-known hard disk company 
discussing how we were supposed to archive tapeless media for the long-term. 

Note: The company he works for is not important, because I've since corroborated 
this issue with two other hard disk companies. This is a hard disk issue, NOT a 
specific vendor issue.

Executive Summary 

Magnetic signals recorded on a hard disk are designed to be refreshed periodically. If your hard 
disks stay on, this happens automatically. However, if you store your projects to a removable 
hard drive, then store that hard drive on a shelf, unattached to a computer, those magnetic 
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signals will fade over time... essentially, evaporating.

According to what I've been told, the life-span of a magnetic signal on a hard disk is between a 
year and a year and a half. The issue is complex, as you'll see, but this is a MUCH shorter shelf-
life than I was expecting.

The way to keep the files on your hard disks safe is to connect the hard drive to your computer 
every six months or so and, ideally, copy all the files from one drive to another. Failing that, use a 
program like Micromat's TechTool Pro, or ProSoft's Drive Genius, to do a complete scan of your 
hard drive. Doing so will replenish any magnetic signals that are starting to fade.

The Technical Details

The issue of magnetic fading has been a little-talked about concern in the hard disk industry for a 
while, but it is complex and simple answers are hard to find. Here are some comments that one 
engineer sent me that may help you understand this better.

This has been something that has come up over the years, in the quest for higher 
density hard drives, before we crossed the 1GB per drive barrier. At that time, 
there was concern because the earth's magnetic field could affect data integrity, 
and many measures were designed to compensate for this effect. At that time and 
since, there was also concern for the magnetic charges on the disk platters. 

Older mainframe storage systems continuously read each sector; this read 
automatically refreshed any sectors that were margina. Servo tracks are also 
embedded within the data tracks, so any signals out of margin were easily 
detectable. Loss of servo info would render the disk useless, as the controller 
would not know where the head really was on the disk surface.

Improvements have been made in head technology, media magnetic qualities, and 
recording techniques to make the data integrity less subject to outside influence, 
and to the fading of the magnetic encoded bits on the disk surface. Sort of like 
when cheap magnets eventually lose their magnetism. Better materials deliver 
longer life.

So...in the interest of checking things out, simply reading every sector on a disk 
actually is preventative; if the controller within the disk detects any marginal data 
in either the servo tracks or the data bits recorded on the surface, the controller 
will automatically rewrite the data to the sector. If it cannot, this block is mapped 
out, again, automatically, and a substitute data block will be mapped in. All 
modern disks do this for you today. A simple read cycle of every sector or data 
block is all that is necessary. 

In the 80's and early 90's this was NOT automatic, and that is where things like 
defragging and bad-block mapping were the norm. Today, a lot of this is done 
automatically for you by the disc itself, or the file system manager in the OS. 
Things are constantly being moved around.

So, the scanning is simply reading every sector of the disk surface. The act of 
copying all the files from one disk to another disk would almost accomplish the 
same thing. With this latter method, unused parts of the disc would not be read 
again.

As for duration: I would say that the disks could lose data if not used for a long 
period of time. Doing this surface scan every year or two is preventative. It is hard 
to define a point in time when a failure due to degraded media occurs. I do have 
drives here that have not been spun up for several years, and they are fine, but I 
have heard from many who do have issues after leaving the drive in storage for 
several years. Sometimes it is actual data fade; sometimes it is power supply 
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related; 
sometimes it is due to extremes in temperature or humidity.

All things age, some more gracefully that others.

Bottom line, revisiting your storage archives periodically is some assurance that 
what you have saved away is really still there. You know the old adage, the only 
thing worse than no backup, is a backup that can't be used.

Larry again. Frankly, I was stunned with this news and wanted to share it with you as soon as I 
could. Please make sure to check your hard drives regularly. Keep multiple backups. And 
consider using tape as a backup while these archiving issues get sorted out. 

Here's an article I wrote recently on backing up to tape that may be useful to you.

[ Go to Top. ] 

A Note on Partitioning and De-fragmenting Hard Disks

As long as we are talking about hard disks, for the last couple of 
years, I have said at a variety of seminars that I am not a fan of 
partitioning a hard drive -- it tends to slow things down.

In learning more about the slow signal fade from magnetic disks, I also learned that partitioning 
only helps when you want to force usage to outer regions of the disk surface. Outer tracks have 
better performance than inner tracks. Partitions can lock out the inner regions, but do so at the 
expense of lowering total storage capacity. Modern drives are much faster, providing more 
performance margin across the entire disk surface. With plenty of head room, things are a lot 
better and partitioning is no longer necessary.

Also, there is no reason, and limited benefit, to de-fragmenting your data drives. Final Cut stores 
media in an "optimized" (fragmented) state to enable clips to play back more efficiently. While de-
fragmeNting your boot drive may be a good idea, defragging your media drives will tend to slow 
things down, as you are removing the optimization that Final Cut is putting in.

Given the size and speed of today's hard drives, I no longer recommend partitioning a hard drive 
into more than one partition or de-fragmenting media drives as a general rule.

[ Go to Top. ] 

Larry's PowerUP Seminar Tour Starting in Sacramento Sept. 8!

Hurry and register now!
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My next tour starts next week in Sacramento and San Diego; 
then travels to 12 more cities in two months. Here's where we will be in September:

�●     Sacramento -- Sept. 8 & 9
�●     San Diego -- Sept. 11 & 12
�●     Dallas -- Sept. 15 & 16
�●     Washington DC -- Sept. 18 & 19
�●     San Francisco -- Sept. 22 & 23 

Important Note: Due to schedule conflicts, I only have time next year to visit 6 or 
7 cities -- I'll select the most popular cities from this year's tour. This means that I 
will not be able to return to many of this year's cities after this trip. Please register 
today before it's too late!

This year, we've created three new seminars:

Seminar 1:  
Succeeding in the New World of Tapeless and HD Video

Manufacturers and distribution are moving to HD 
and tapeless as fast as they can pull the tape drives 
out of new cameras. But this new workflow requires 
us to have a much different technical understanding 
of how this stuff works. This 4-hour seminar 
answers key questions like:

�●     What is the right HD format for my work?
�●     What gear do I need to move to HD?
�●     Where does ProRes fit in?
�●     How can I get better organized?
�●     How do I trouble-shoot my system?

Seminar 2:  
Integrating Adobe Products into a Final Cut 
Workflow

Every editor I've ever met uses 
Photoshop, but did you know PhotoShop does video editing, too? 
DVD Studio Pro does not support Blu-ray Discs, but Encore does. 
Final Cut Server can help you locate files, but so can Bridge, for a 
fraction of the cost and much better than you might think! 

This 4-hour seminar shows you how to:

�●     Find and catalog files in Adobe Bridge
�●     Clean-up video images in Photoshop
�●     Easily move files between Final Cut Pro and After Effects
�●     Create better Flash videos
�●     Test your videos on hundreds of mobile devices
�●     Integrate Adobe Production Premium with Final Cut Studio 

Seminar 3:  
Discover the Hidden Power in Final Cut 
Studio

The number one request from our 
seminars last year was "show me 
more...". So this 8-hour seminar show 
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you how:

�●     To repair poor audio
�●     To do better audio mixing
�●     To create and monitor surround 

sound 
�●     To customize royalty-free music 
�●     To automate compression for DVDs 
�●     To create a Blu-ray Disc 
�●     To create Flash videos
�●     To transcode HD to SD

In other words, if you want to improve the sound of your projects, or 
the look of your finished video, this seminar is for you.

Economically, I realize that times are tough. However, I've designed my 
seminars to save you time and money with every job, plus show you 
techniques that will blow your competitors out of the water. I can help you 
avoid wasting money and time. 

The tour starts next week and it's over in two months. You don't have any 
time to waste. Sign up today -- I don't want you to say "I shoulda gone..."

Click here for more information.

Click here for a list of cities.

Click here to register. Sign up today and reserve your seat! 

Thanks to our sponsors! 

I am very grateful for the support of our sponsors. Putting on a tour of this 
magnitude takes a lot of hard work and money. This would not be possible without 
the generous support of our platinum sponsor: Adobe Systems; our gold level 
sponsors: Blackmagic Design, Media Distributors, and The Rental Station, 
and our silver level sponsors: Automatic Duck, and SmartSound.

[ Go to Top. ] 

Apple Ships ProRes 422 QuickTime Decoder

One of the knocks against a wider adoption of ProRes 422 - Apple's latest codec - was that it 
only ran on Mac systems and it required Final Cut Studio to be installed.

Neither of those are true any longer.

Last week, Apple released The ProRes QuickTime Decoder 1.0. This free software allows both 
Mac and Windows users to play Apple ProRes files through QuickTime. Apple ProRes is a 
visually lossless format that provides uncompressed HD quality at SD data rates. The decoder 
runs on both OS X 10.4 and 10.5. However, it requires QuickTime 7.5.

According to Apple:
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This software makes ProRes an excellent choice for mastering and can easily be 
transcoded to distribution formats like H.264. With new support for playback on 
both Mac and Windows computers, Apple ProRes can also be used for review and 
approval of Final Cut Studio sequences.

ProRes is NOT a distribution format, it is an editing format. In fact, in order to edit AVCHD, AVC-
CAM, AVC-Intra, and other highly compressed video codecs, we need to transcode them into 
ProRes prior to editing. The good news is that now, Apple is providing a workflow that allows 
ProRes files to be played on both Windows and Mac systems.

Click here to learn more, or download the decoder.

[ Go to Top. ] 

Technique: Understanding the Selection Tools

If you haven't discovered the Search button on my website, you are missing a treat. 

Every article I've ever written is fully-indexed. Simply type in the word 
or phrase you are looking for and a list of all the relevant articles 
appears. We currently have over 400 techniques and tutorials -- all 
free -- for you to browse through.

I was wandering around the library looking for something to write, 
when I realized that I haven't talked about the three selection tools inside Final Cut Pro.

The selection tools are located in the Tool palette, just below the top Arrow / Selection tool. 
Here's what they do.

The Edit Selection tool selects edit points. Select the tool (or type G), then drag to select the 
edit points you want to work with. Final Cut only allows one selected edit point per track, but if 
you are layering clips, selecting multiple edit points can be really useful.

For instance, to get multiple stacked clips to all start, or end, at the same time, put the playhead 
at the point you want them to start or end, select all the edit points using the Edit Selection tool, 
then type E. Provided you have sufficient handles, all the selected edit points will immediately 
jump to the location of the playhead. I use this technique constantly when I am building effects.
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The Group Selection tool selects clips. Which, for those of us who have used Final Cut Pro for 
more than about two minutes, is exactly what the Arrow / Selection tool does. So, why add a tool 
to repeat these functions.

Well, the answer is that the Group Selection tool ONLY selects clips. You can't move them with 
this tool, as you can with the Arrow tool. This means that if you absolutely, positively MUST 
select a clip, or group of clips, with ZERO risk of moving it, the Group Selection tool is exactly 
what you need. Try it, and you'll see what I mean -- it selects but can not move. Its keyboard 
shortcut is GG.

The Range Selection tool allows you to select a range within a clip or across a group of clips. 
This can be useful if you want to apply a filter to a portion of a clip, but not the whole clip. Or you 
want to delete a portion of a clip, but not the whole clip. The ability to select a portion of a clip 
without necessarily forcing an edit point can be very useful. Its keyboard shortcut is GGG. 

Here's an article that describes using the Range Selection tool in more detail.

While I don't use these tools often, when I need them, I'm very grateful they are there.

[ Go to Top. ] 

Larry Has a New Blog!

I love writing this 
newsletter, but it 
takes a lot of time, 
and I generally 
only have time to 
do this once a 
month. 

While this allows 
me to concentrate 
on techniques and 
longer articles, our 
industry is changing too quickly for a single monthly publication to keep up. So, I've started a 
Blog -- you can see it here: www.larryjordan.biz/blog.

My hope is that this will allow me to respond much faster to your questions, emails, industry 
news, and things I learn hosting the Digital Production BuZZ that can't wait a month. I'd like this 
to allow me to do a better job of keeping you informed. 

Best of all, we've designed this so you can add comments and share these postings with others 
-- my hope is to extend the community we've built with this newsletter into something bigger and 
more timely for all of us. 
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Take a look and let me know what you think. While I can't guarantee to update it every day, my 
plan is to update it several times a week.

[ Go to Top. ] 

11-Step Final Cut Pro Workflow

I want to talk about making money for a few minutes. 

As editors, the way we make money is selling our time. (Yes, I know there is a craft to editing, 
and technology, and experience, but at the end of the day, the unit of measure for all of this is 
time.)

And one of the frequent problems I see is that it is very easy for editors to get distracted from 
what we SHOULD be doing to what we WANT to do. This means that we are wasting a lot of our 
time - which costs us money.

One of the guiding lights of my seminars is to show you faster ways to do things. If you can 
achieve the same quality in your projects in a fraction of the time, this instantly equates into 
either more free time, or time for more projects. Both are highly desirable goals.

When I was writing my first book on Final Cut Pro a few years ago, I developed a nine-step 
editing workflow that answered the question: "What should I be doing right now?"

However, over the years, I've learned more and Apple has released new software, so this nine-
step process has become a bit outdated. Today I want to revisit and update it. Especially for 
editors that are new, or just getting back into the industry, my hope is that in following these 
steps, you'll have a better way to keep track of what you should be doing "right now."

At its heart, editing is story-telling, regardless of whether that story is a feature film, wedding, 
corporate training, or a commercial. The best videos are always stories. And, like all stories, 
videos get better the more you polish them. This workflow for editing within Final Cut Pro helps 
you decide where to best spend your time.

Since there is never enough time to get everything done, it is important to make sure you are 
spending your time doing the right thing. That's where this 11-step approach can help. 
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Here's the overall rule: don't start a step until all the prior steps are complete. For instance, it 
makes no sense to spend time adding and polishing transitions when you aren't even sure what 
your final shot order is. All the time you spend adding and adjusting a transition becomes wasted 
when you delete one of the two shots it is attached to.

With that in mind, here is the workflow:

Step 1: Plan your project. Develop a consistent file naming scheme. Set your 
scratch disks, then leave them alone. Create a project folder to store all your 
project elements and non-timecode-based media. Think about who your audience 
is and how you want to reach them. Planning is never fun, but it is essential to 
successfully completing a project. Here's an article that can help you get 
organized. 

Step 2: Gather your media. Capture media from video tape. Ingest any tapeless 
files. Import audio and graphics. Use bins in the Browser to get organized and 
make it easy to track all the different elements of your project. Figure out what you 
have and what you need to create.

Step 3: Build your story. View your clips. Set In's and Out's and edit them into 
the Timeline. Don't worry, yet, about precision. Just make some basic decisions 
on which clips are in and which are out. The goal here is not to strive for 
perfection, but to get the ideas you have in your head edited into the timeline so 
you can decide whether they work or not. Until you have something in the timeline, 
there's nothing to review and polish.

Step 4: Organize your story. Watch your sequence and make decisions on the 
order of your clips. Delete the clips that don't work. Insert clips that are missing. 
Shuffle clips around to make your story flow better. Don't worry about making each 
edit perfect. Concentrate on improving the flow of your story. 

Step 5: Trim your story. Once the organization of your story is complete and 
your clips are in the right order, now it's time to start trimming your edit points so 
that your edits become invisible. There are two reasons to trim: to improve the 
story, or to get your story to fit for time. What I recommend is trim to improve the 
story first, then see what you can do to get everything to fit for time.

Step 6: Add transitions. Transitions are fun and sexy, but you've only got limited 
time. Focus on what needs to be done first. Hard as it is to believe, people will still 
watch your program even if it only contains cuts! (Strange, but true.) They can't 
watch your show if you never get it done. There are three categories of transitions: 
cuts, dissolves, and wipes. A cut is a change in perspective, a dissolve is a 
change in time or place, and a wipe totally breaks the flow of the story to take you 
somewhere entirely different. Be cautious not to overuse dissolves, and only use a 
wipe when you want a complete disconnect between what came before and what 
comes after.

Step 7: Add text and effects. Now that your story is complete, you can afford to 
spend all your remaining time adding text and effects. Keep in mind that there is 
no right answer on what is a good effect. If it looks good, within the context of your 
project, then go ahead and use it. However, don't bog down too early in effects, or 
you'll spend all your time creating effects, only to discover that your story isn't 
complete. In general, effects will suck up all the remaining time in your project, 
plus about a week.

Step 8: Mix your audio. While you've been editing your audio all along, now is 
the time to start adding sound effects, music, background and atmosphere. This is 
often called audio sweetening. The best thing you can do to improve the quality of 
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your picture is to improve the quality of your audio. If you are part of a team editing 
this project, feel free to send drafts to the audio folks so they can start planning 
their mix. If you are doing the whole thing yourself, hold off audio effects and 
mixing until you've decided the picture is locked, otherwise, you can end up 
spinning your wheels.

Step 9: Color correct your video. This is the last step of your project - making 
everything look great. Whether you color correct in Final Cut Pro or Color, save 
this step until everything else is complete.

Step 10: Output your project. When everything is done -- or the deadline has 
arrived -- output your media to tape, or the web, DVD, or a hard disk file. When 
outputting to tape, use File > Print to Video, unless you need to output to a 
specific timecode on the tape. If you are exporting a file, always use File > Export 
> QuickTime movie for the fastest export at the highest quality.

Step 11: Archive your project. Save that which needs to be saved, and trash 
that which can be trashed. Remember, there are two rules in our industry: 

1) No one actually looks at the final version until it has been laid to 
tape. 
2) Someone will always want changes two days after you take the 
project off your hard disks.

Backups are ALWAYS necessary. 

Click here to read an article that gives you much more detail on how to set your 
system up for archiving.

If you focus on doing what needs to be done right now and ignore getting distracted by those 
tasks who's time has not yet come, you will get your projects done more quickly and with less 
wasted activity.

[ Go to Top. ] 

KenStone.net Reviews the CalDigit HD-One

Ken Stone just posted a review by Chi-Ho Lee on the CalDigit HD-One RAID.

I've been a fan of CalDigit for a while - and thought you'd like to see this review as well.

http://www.kenstone.net/fcp_homepage/caldigit_hdone_lee.html

[ Go to Top. ] 

Larry Releases New Training Video - Moving on Stills

We've released a new training video -- Moving on Stills in Final Cut Studio!

Produced in conjunction with Lynda.com, this two-and-a-half hour training DVD shows you how 
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to size your images, prep your images in Photoshop, how to build them into a Final Cut or Motion 
timeline, and, best of all, how to add movement and transitions and still see what you are 
working on.

This is a very cool title for anyone doing documentary, wedding, event, or other projects that 
require extensive use of stills.

You can order our newest training title here.

Also, check out the demo move to see what this title contains.

[ Go to Top. ] 

Looking for New Subjects for Training

I'm looking for ideas on what you'd like me to cover in future training. From our training videos to 
Edit Well, this newsletter to Digital Production BuZZ, we are always interested in your ideas. 

Drop me an email and let me know what you'd like to see.

[ Go to Top. ] 

Technique: Creating Extremely Slow Motion in Motion 2 or 3

Karen Irvine, from Blind Eye Productions, and Jeff Cipin, from Toronto, both sent in separate 
questions similar to this:

Some time ago you demonstrated how to create very smooth slow motion using 
Motion. Unfortunately, I can't find my notes and I seem to recall it was something 
different that just using the "Set Speed" function in Motion 3.

Larry replies: Karen and Jeff, thanks for writing.

This process is called Optical Flow, and while it has its problems, when it works, it works great. 
There are a number of ways to do this, here is an easy method:

1. Edit the clip you want to slow down to the Final Cut Timeline. (While Optical 
Flow can be used to speed up a clip, its primary benefit is in slowing things 
WAAAY down.)
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2. Select the clip, go to Modify > Speed, and enter the speed you want the clip to 
run. Numbers smaller than 100% slow the clip down; numbers greater than 100% 
speed the clip up. In this case, I've slowed it down to 10% of normal speed.

3. Control-click on the speed-changed clip and select Send to > Motion project.

4. In the resulting dialog box, give this effect a name (I used "slomo clip 01") and 
leave both checkboxes checked. This will start Motion, load the clip into Motion, 
and replace the original clip in the FCP timeline with the new, improved Motion clip.



5. When Motion starts, the selected clip will appear in the Canvas. Click once on 
the image to select the clip.

6. Go to Inspector > Properties, then twirl down the Timing tab. The second pop-
up from the bottom will say "Blending." Change it to Optical Flow.

7. This starts a lengthy calculation where Motion tracks the movement of every 
pixel in every frame. Depending upon the speed of your computer, I've found that 
it takes about 10 seconds to calculate each frame in SD, and about a minute to 
calculate each frame in HD. Your timings will vary. You can tell that Motion is 
calculating by the small spinning gear in the low-center of the Canvas.

8. To see how long it will take to calculate the shot, click once on the spinning gear 
to view the Background Task List dialog box.

9. When the calculations are done, save the Motion project and switch back to 
Final Cut Pro. Your clip is instantaneously updated with the new version. Simply 
render the shot (as Motion always saves at the highest possible quality) and you 
are done.



  
  
  
  
  
  
  
  
  
  

There are also a couple of notes to improve your success in using Optical Flow. 

First, cameras that are locked down always do better than hand-held shots. Shots with rapid 
pans or tilts, even when on a tripod, are also a problem. The key is to have ONLY the object you 
want to slow down be moving in the frame. The more the background moves, the harder it is for 
the software to figure out what to slow down.

Second, objects which have a high contrast level with the background create a better looking 
effect. Things start looking really funky when the foreground and background match too closely.

Still, when this effect works, the results can be stunning.

UPDATE - Sept. 2 

Jonathan Tyrell writes: 

One thing you may want to warn your readers about, especially the more casual 
Motion users, is the size of the file generated by Motion to create the Optical Flow 
effect. In my experience they get big pretty quickly, even with DV25, and the 
default cache location is your system drive! A quick trip to the Cache tab in the 
Motion Preferences will give you an opportunity to choose a more appropriate 
location.

Larry replies: Thanks for mentioning this. Optical Flow cache files (which are created during 
analysis) require about 2.7 MB per frame for DV and 16 MB per frame for 1080 HD. Make sure 
to change the default location of your Motion cache files from your boot disk to a large second 
drive in Motion > Preferences > Cache. 

Also, Optical Flow analyzes the entire clip, not just the portion you have marked with an In and 
an Out. Keep your clips short, or create separate self-contained QuickTime movies. 

[ Go to Top. ] 

Digital Production BuZZ Official Podcast of DV Expo and Government Expo!

The folks at NewBay Media have asked us to be the Official Media Partner of DV Expo - Nov. 4-
6 at the Los Angeles Convention Center.

 

DV EXPO 

If you are a videographer, cinematographer, director, producer, camera operator, 
editor, post supervisor, sound editor, motion graphics designer, web video 
producer, corporate video producer or documentary filmmaker ... THIS IS YOUR 
EVENT!

More than 45 conference sessions and top industry exhibits showcasing hundreds 
of new products await you and your questions. These three days will be packed 

http://www.dvexpo.com/


with education and information you won't get anywhere else! 

No sooner did we say yes to covering DV Expo, than NewBay Media came right back and asked 
us to be the official Media Partner for Government Expo - Dec. 2-4 at the Walter E Washington 
Convention Center in Washington, DC.

GOVERNMENT VIDEO EXPO 

Government Video Technology Expo reflects the diversity of the government video 
market, including state and local government, law enforcement and federal 
agencies. And of course our men and women in uniform. GV Expo delivers an 
exhibit hall with more than 200 vendors, certification and training classes in post-
production and a wide reaching Government Video conference program covering 
issues in video, audio, multimedia, conferencing and broadcast. This is a one-of-a-
kind event designed to bring government buyers and sellers together. Register 
today. 

We'll be originating two hours of live coverage every day of the three day event. 

We'll have more on this as we get closer. But, if you can free up a day 
in your calendar, come on over to the show and say "Hi!" We'd love to 
see you.

Click here for DV Expo.

Click here for Government Video Expo.

Click here to learn more about The BuZZ.
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Understanding Handles

Handles, extra video before the In and after the Out of a clip, are essential for trimming and 
adding transitions. However, that doesn't mean they are easy to understand.

As Steve wrote:

I have been putting a few page peel transitions between clips, all of the clips are 
similar. The transitions worked fine on all of the clips except one, it only showed 
the transition for a split second (1/60th to be exact). I went into the durations 
setting for that one transition and typed in 1 second but it wouldn't allow me to 
change it. What should I do?

Larry replies: Steve, the problem is that whenever you add a transition between two clips, it 
needs extra video before the In and after the Out. By default, this extra video is equal to one-half 
the length of the transition. So, if your transition is 30 frames, you will need 15 frames of extra 
video before the In and after the Out at the point of the transition. 

http://www.gvexpo.com/
http://www.digitalproductionbuzz.com/
http://www.dvexpo.com/
http://www.gvexpo.com/
http://www.digitalproductionbuzz.com/


That small 1-frame icon is the giveaway that one of your two clips doesn't have enough handles. 
Take a look at this article, which I recently updated, to learn more about handles:

http://www.larryjordan.biz/articles/lj_handles.html

If you have a transition that doesn't have enough handles, you can use the Ripple tool to move 
the offending In or Out, thereby shortening the clip and providing sufficient video for your 
transition. 

To learn about how the Ripple and Roll tools work, read this:

http://www.larryjordan.biz/articles/lj_trimming.html
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Capturing Old Footage

Don Riley sent me these questions a while back about how to capture old, archived footage. He 
writes: 

I have a collection of over 100 tapes of Big Game fishing which I've been doing for 
over 40 years and include famous people, world records (with many fish in excess 
of 1,000 pounds}. After being pestered by everyone I finally made a few DVD's 
with iMovie and won first prize at the Miami International Boat Show in 2005, if you 
can believe that. It was the content, of course, not the editing. 

in 2006 I was struck with cancer and my activity ceased but since last Dec. I've 
recovered and to keep my mind active I bought a MacBook Pro 2.6GHZ 4GB RAM 
etc. My goal now is to capture, log, catalogue and create a library that can access 
any scene needed for editing, i.e. heavy seas, underwater reef, sunsets, giant 
marlin, the list goes on. I've run into a problem -- my old sony DV camera was able 
to convert all the Hi-8 film until it finally died. I need something to get it on on my 
scratch disk.

In addition, I'm leaving in Sept. for the Great Barrier Reef and will be there till next 
Jan. The skippers and crews of the Marlin fleet will give me all their tapes -- you 
can imagine the media I'll have. They are like family to me. I've been going there 
for 25 years, they don't part with their tapes. So the task is to capture all this. Any 
guidance would be appreciated.

Larry replies: Don, you have lived an incredible life...! Thanks for writing. 

You have several issues here:

1) You need to capture the tapes at the same quality at which they were shot. 
However, since you are dealing with a potentially vast array of video formats, it is 
critical that you capture them at the highest quality and NOT compress them too 
soon.

2) You not only need to capture them but to log them and make them accessible 
to others.

http://www.larryjordan.biz/articles/lj_handles.html
http://www.larryjordan.biz/articles/lj_trimming.html


3) You need to archive this footage so that it doesn't get lost.

Capture - Catalog - Archive.

All this is doable, but it is not inexpensive or fast. All this can be done by one person, but it is a 
LOT of work and may exceed what you are interested in doing. 

Here's a short summary of what you need to do:

1) DV video takes 13 GB per hour to store. Buy enough hard disk space to store 
everything, plus leave about 20% free on each disk. DO NOT compress the video 
- you will regret it as soon as you start to edit. Capture DV as DV. For safety, and 
assuming you have reasonable AC power, I recommend a RAID 5 from Dulce 
Systems, or CalDigit.

2) Dub all VHS tapes to DV using a time-base corrector - like the DataVideo 
TBC1000

This allows you to return the original tapes to the people that contributed them. 
You can make a higher quality copy than the source tape, then capture it frim DV 
using FireWire at high quality for editing.

3) Cataloging is where the most time will be spent -- making sure clips are 
properly entered, tracked, and metadata entered. Final Cut Server can be used, 
but it isn't cheap and it takes a professional to install. You might also look at 
CatDV or Apple Filemaker as a temporary workaround.

4) Archiving - short term, this means making copies of all your hard disks - in case 
a disk fails, you don't lose media. This covers you for a couple of years. Longer 
term, you need to archive to tape - ideally, LTO-3 or LTO-4 tape.

When archiving, do NOT create a video DVD - you are losing quality. DVDs are for 
final distribution, not archiving.

Finally, get some help with this project. You can have some people dubbing, while others are 
capturing and others are cataloging.

It sounds like a great project - I wish you tremendous success.

[ Go to Top. ] 

Upgrading is an Adventure

Mary Lou Sheets has been keeping me informed on her never-ending upgrade process. I 
thought I'd share some of this with you.

Well, I took your suggestion on my options. So, I bit the bullet and bought the 
update to FCP Studio 2.

I brought it home and try loading it in. It said I had 512 MB memory and I needed 
1024. I had installed (2) 512 MB and (4) 256 MB (I have a G-5/Dual drives). I 
should have had enough. So the Apple store told me to go somewhere else to buy 
memory, they would charge me $500.00 for 1 GB.

http://www.dulcesystems.com/
http://www.dulcesystems.com/
http://www.caldigit.com/
http://www.datavideo.us/tbc-1000.html?search_category_id=54
http://www.datavideo.us/tbc-1000.html?search_category_id=54


I went to Circuit City, they wanted $100.00 for 1 GB but it was on sale for $40.00 
but sale was over and they were out of memory. So I went to Best Buy, they were 
on sale 1GB for $55.00. I brought 4GB. I can load up to 8 GB. That should do it! 
LOL. I installed in the memory myself. I took out all the old and put in the new. At 
first it would not start up just kept flashing off & on. So after hours, I figured I would 
try the top 1/2 in slots 1 & 2 the bottom 1/2 in slots 3 & 4. It worked!!! 

So I am now loading software, on the last 4 disks 3 audio content and 1 is Apple 
pro training. The computer stalled when I went from Audio content disk 1 to 2. It 
just said to load Audio content disk. I took out disk 2 & put in disk 1. It finally 
kicked, and I am loading now. Why did it freeze like that? I can't wait to try FCP 
tomorrow after work. 

I talked to Apple care people. He told me how to take a picture with your 
computer. I brought up my serial # and pressed Command+Shift+3. It stored my 
pic on my desk top! Pretty neat! You should share that with people in your next 
news letter. Maybe share about loading memory in a Apple computer. Save 
someone the hassle of paying for it. Thanks again for all your help and input. Keep 
being direct with people and not sugar coating things. 

Larry replies: Mary Lou, thanks for writing. 

Several notes here: first, Macintoshes are very finicky about RAM. Make sure you are buying 
RAM that is certified for a Mac. Second, memory needs to be installed evenly in banks. So, you 
have upper and lower memory slots. You need to put the same size memory in both upper and 
lower slots so they balance. 

Finally, the process of installing Final Cut Studio takes a LOT of hard disk space, and LOTS of 
time. Just because the system isn't doing anything on the surface, doesn't mean it is frozen. Be 
sure to give the system lots of time to install from the discs. I've seen installations which can take 
2-3 hours. Bring a book.
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Thoughts from a User Group Newbie

Don Ray thought I was Mike Horton -- the head cutter of the Los Angeles Final Cut Pro User 
Group, and my co-host on Digital Production Buzz. I can understand the mistake -- if you ever 
see us together, the resemblance is uncanny... 

Anyway, he sent in this long email about his experiences attending a user group for the first time 
and his thoughts on improving the user group experience for new attendees. I'm reprinting a 
portion of it with his permission because I think all of us that try to share technology with others 
can learn from his observations. 

I come to the meetings because I have specific questions that are probably so 
simple and elementary that it would be a waste of everyone’s time to ask them in 
the group setting. Furthermore, there is so much nomenclature that people throw 
about that I have no clue how to even put the question into words – again, without 
tying up the valuable time allotted for questions. 
 
Indeed, I would love to connect with other people at the meeting – people who 
could easily help me solve my simple problems. However, aside from being a bit 
shy, I’m still not comfortable walking up to someone and saying, “Excuse me, but 
do you know how I can handle this particular problem?” 



 
I think that your desire to have people network and share stuff is great. I believe, 
however, that there are many of us who aren’t able to pull it off. I know that when I 
try to talk to the vendors you invite, I haven’t a clue what they’re talking about. 
They may have a great product or service, but they’re talking the same jargon, 
acronyms and technical stuff that just about everybody else seems to be talking. 
It’s like being in a foreign country and not knowing the language. 
 
You’re going to laugh at me, but I was excited to see that there was going to be a 
presentation about Blu-ray. Why was I excited? Because I thought somebody 
would tell me what it is. OK, stop laughing, but I don’t know what it is. I don’t 
believe that anyone in the room would have objected if the speaker would have 
first explained what it was. There was a line on the screen that read something 
like, “The history of Blu-ray.” Bingo, I thought. But then he didn’t give the history of 
it. Oh well, I took notes, but I don’t know why. 
 
Also, most of the speakers race through the answers to question faster than I can 
write. I can’t see how they got from one place to another on the screen and I don’t 
know what the acronyms and terms are that they’re using. Now maybe everybody 
else in the room can keep up with it, but I cannot. Maybe, however, there are 
dozens of people who haven’t a clue what they just heard and saw. Maybe they 
throw in the towel and decide to not return. Maybe, like me, they wish that there 
were a way to ask someone some simple questions. Maybe, like me, they wish 
they could know whom they could approach with a stupid, simple question. 
 
Maybe I’m not the kind of person you had in mind when you started putting the 
users group together. Maybe my feelings of not belonging are genuine, but I hope 
not. I hope that the group is meant to be friendly – even to beginners. Heck, you 
have high school kids coming. How dumb must I feel if they’re getting it and I’m 
not. 
 
OK, the suggestions:

1.  Turn up the volume on the microphones and ensure that each speaker 
speaks clearly into the mike. I’m a back of the room lurker but there’s so 
much noise from the people setting up things in the lobby that I can’t hear. 
I’m not alone. 

2.  Ask the speakers to at least solicit the audience before assuming that they 
all understand the concept and the terminology. It’s easy to do. “How many 
people here know what Blu-ray is?” Notice how I didn’t suggest, “How 
many people don’t know . . . “? That’s because people don’t like to raise 
their hands and show their ignorance. I know that this is not logical, but it’s 
real. Or, “On a scale of one to ten, ten being an expert, how many people 
believe their knowledge of this subject is a five or above? It only take a 
minute to find out that you’re talking over the heads of many of the people 
in the audience. Could these be the people who are not returning? 

3.  Put out the word that starting at, say 6 p.m., there will be one or more 
experienced users who will be available to answer the most basic of 
questions. You could call it something funny or something serious: 
“Bonehead question,” “Learning to Crawl with FCP,” etc. Heck, I’d come 
super early if I knew someone would be there to take the time to explain 
stuff – and not at the expense of the veterans who come for much more 
technical and sophisticated help. 

4.  Expand the break a bit and have four or five tables set up outside or inside 
or whatever where people could go to talk to volunteer “helpers” at different 
levels. In fact, there could be five or six experienced people at each station 
– people who might simply agree to exchange e-mail addresses or other 
contact information and offer help after the meeting or remotely. Oh how I’d 
like to buddy up with someone who had the time and willingness to answer 
my silly, simple and stupid questions. How long does it take to tell me, yes 
or no, if I allow FCP software to update itself, will it go from 5.6 (or 
whatever) to 6.3? I subscribe to and use Lynda.com’s great tutorials, but 
when they say, “Don’t update the software automatically – it’s better to load 
the entire upgraded program.” OK, do I go out and buy it? Do I buy it 



online? Does it come with the price I paid for the software program? These 
are the questions that wouldn’t take long to answer. 

5.  Have the helpful and willing experienced people wear a distinctive name 
tag that says, “Ask me anything about FCP – I’ll try to answer your 
question.” 

6.  When people register, have them fill out a simple, easy card that has, at 
least, a place for their name and e-mail address. Then, provide a small 
place for one basic question. Then have somebody glance through the 
questions while one of the other sessions is taking place. Before the break, 
maybe someone could tell the group that there are a lot of questions about 
X or about Y or Z and that there will be someone at the “Question table” or 
at the computer in the auditorium to provide answers to the most-asked 
questions. 

7.  Before you wrap up, ask the group if there are pros or experienced folks 
who would be willing to take one card with an unanswered question and e-
mail the person with a possible answer. See if maybe there would be one 
or two people who would be willing to stay a few minutes late to answer 
questions. 

8.  Offer a “Second-time attendee prize” – one of the big prizes. You ask 
everyone in the audience to stand up if it’s their second time coming – 
second time only. Somehow come up with a random month and day of the 
month. Let’s say that the date you pick is March 17th. You ask if there’s 
anyone born in March. If there’s only one, that person wins the prize. If 
there’s more than one, everyone not born in March sits down. Then you 
find out whose birthday is closest to the 17th. That person wins a big prize. 
Everyone else in the room will know that there’s at least one good reason 
to come back.

I hope that you don’t mind that I suggested these things. I do a lot of public 
speaking and training over the years and I’ve come up with some techniques that 
ensure participation and that anticipate the obstacles some people have to being 
comfortable.

Again, thanks so much for putting on the great meetings. It’s clear that you and 
others go to a lot of trouble to make it happen. And it’s clear that you have a 
strong following. I’m humbled by the knowledge of the people around me when I’m 
there.

Larry replies: Don, one very important point for everyone attending a user group -- NEVER be 
afraid to ask questions, either in the group, the break, or afterward. No one knows as much as 
you think they do, and if you ask, everyone benefits when they hear the answer. Plus, everyone 
there is interested in learning more about how the software, or the industry, work.

Every one of us started by not knowing anything. There is never a stupid question. However, 
sometimes, those of us who have been presenting for a while forget that. Thanks for reminding 
us.

Blu-ray Discs, by the way, are a new DVD technology spear-headed by Sony, that promises 
vastly greater storage on a DVD that looks the same as a standard DVD. The problem with Blu-
ray is not their greater storage, it is in finding software that allows us to design and burn these 
new discs for a reasonable price and using software tools that we already know how to use.

For example, see the next letter.

[ Go to Top. ] 

READER MAIL



AUTHORING BLU-RAY DISCS

Mike Henry, from Atlanta, writes:

As I am sure you hear daily, I love reading your 
newsletters. Thank you for spending the time on 
them and for sharing your experience.

I have what I am guessing is a pretty common 
question lately. I was curious with your experience 
with Apple if you have heard any updates on the 
availability of Blu-ray support for DVD SP4 or an upgrade to DVD SP? If not, do 
you have any other suggestions for authoring Blu-ray discs aside from purchasing 
the full Adobe suite to use Encore? I am very excited to start shipping Blu-ray 
discs to clients and I am open to any ideas that you or others may be using 
currently.

Larry replies: Mike, the number one rule at Apple is NEVER discuss unannounced products. So, 
therefore, I don't know what Apple is planning for the future. I have every expectation that they 
are monitoring the Blu-ray situation and will announce something at some point.

In the meantime, however, you can author Blu-ray discs on the Mac using two different software: 
Adobe Encore or Roxio Toast. However, to take full advantage of the Blu-ray interface, you'll 
need to step-up to something like Sonic's Scenarist, or Sony's Blu-print -- both of which are 
upwards of $20,000 to license and require a significant amount of programming skills.

But I have a more fundamental question for you: who's going to watch your Blu-ray Discs? Be 
careful here. The total market penetration for Blu-ray is still vanishingly small -- less than 5% of 
the SD set-top DVD marketplace. 

For the immediate future, spend time seeing just how many customers you have that can play a 
Blu-ray. Also, it currently appears that while people are buying HD televisions, they are not 
buying DVD set-top boxes to go with them. At this point, unless you can afford to experiment, Blu-
ray is not a area where the small producer is going to make money.
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BATCH-CLEARING DURATIONS

Emile Guertin, from Singapore, writes:

Quick question from me here in Singapore...

How do you batch-clear 'in and out' points on a list of clips in FCP? For example, I 
have highlighted ten clips I want to drag onto the timeline to make a quick 
assembly. The problem is, when I create this assembly, FCP only uses sections of 
the clips I have left marked in & out from a previous task.

Larry replies: Simple -- once you know the trick. You can do this in three steps:



1. Select all the clips in the Browser which have durations you want to clear. 
2. Control-click in the In column of the Browser and select Clear In at the bottom 
of the menu. 
3. Control-click in the Out column of the Browser and select Clear Out.

At this point, all clip durations are reset.

[ Go to Top. ] 

TRANSCODING HDV TO PRORES 422

Last month's HDV article drew questions from both Catherine and Issa Edah-Tally, which I've 
summarized in Catherine's question below.

Catherine writes:

In a recent newsletter you wrote: 

The currently accepted HD workflow for professional-grade work in 
FCP is: shoot in whatever format you want (HDV, XDCAM HD, 
DVCPRO HD) then transcode into ProRes during capture, or as 
soon thereafter as possible.

Edit your sequence in ProRes, then output to D5 or HDCAM for 
distribution. The output would require a capture card from 
Blackmagic Design or AJA to convert the ProRes into a release 
format.

I am editing with a Mac OS X 10.4 using FireWire in and out. Do I need to 
purchase a Blackmagic Design or AJA card to get the footage into the computer 
and back out. Could you create a simple diagram so that I might better understand 
the process?

Larry replies: Catherine, you don't need a capture card provided you have a fast enough 
computer. To make sure I understood this, I contacted a friend at Apple who wrote:

To follow up on the HDV to ProRes question, we can do it over FW, but with 
restrictions. We have the "iCodec" path (the HDV capture path we developed for 
iMovie/FCE). This supports transcoding by default to Apple Intermediate Codec, 
but we added support for transcoding to ProRes in FCP 6.0.2. Users have to 



choose "HDV-Apple ProRes 422" or "HDV-Apple ProRes 422 (HQ)" for their 
capture preset. This capture path does not have all the Log & Capture capabilities 
-- it is basically just "Capture Now" functionality only.

Larry continues: There are two problems with this approach. First, Capture Now functionality 
generally means that you can capture the footage, but you'll have a lot of problems if you ever 
need to recapture it, due to inaccuracies in timecode during capture. Also, if you have a slower 
computer, for instance a non-Intel system, you may not be able to capture to ProRes in real-time.

For fast, modern computers, try the above approach first. 

If that doesn't work, capture HDV natively using Log & Capture. It is CRITICAL to match your 
capture settings to the settings you used on your camera to record your footage. For instance, 
Sony tends to shoot HDV 1080i/60. JVC tends to shoot 720p/60. You must match the codec, 
image size, interlacing, and frame rate between Final Cut Pro and your camera to be sure of 
getting accurate captures.

Once you have the clips captured, change your Sequence > Settings > Render tab codec 
setting so all render files for HDV are in ProRes.

The advantage to this is that all your video will be captured HDV native, but renders (that is all 
effects and transitions) will be processed at the higher quality and faster speed of ProRes.

The downside to this is that render files will be about 4x bigger. The advantage is greater speed 
and quality.

When time comes to output, the actual output speed using ProRes render files is essentially the 
same as using native HDV.



For me, this is a better way to work with HDV.
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EXCESS LUMA LEADS TO EXCESS

Scott Shama writes:

Hope you don't mind me asking this. I previously attended one of your PowerUP 
tours here in Portland, Oregon.

I am color correcting in FCP 6.0.3... If I look at a clip on the histogram with the 
Range Check off, the clips whites are illegal (higher that 100 white, in the red). If I 
turn the Range Check on, the whites drop down to within legal limits.. Why is this? 
I can't figure out why the Range Check should have an effect on the white levels... 
I thought it was just measuring them... I've tried to find information about this 
online but have had no luck...

Any help would be greatly appreciated.

Larry replies: Scott, thanks for writing -- and remind your friends to attend the nearest PowerUP 
seminar.

Turning Range Check on distorts the scopes. The best advice is to turn it only long enough to 
make sure your white levels are OK, then turn it back off again. Leaving Range Check on will 
cause inaccurate scopes.

By the way, what Range Check is measuring is the white levels in your image. If the checkmark 
is green, your levels are OK. If the checkmark is yellow, the white levels have exceeded 100% 
and are outside broadcast safe specs. Use either the Broadcast Safe video filter or the 3-way 
Color Corrector to get them back into safe levels.

Here's an article that describes this in more detail. 
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HDV'S RECTANGULAR PIXELS

Leo Diaz writes:

I have my settings right in Final Cut Pro, I believe. However I have a question.

In the easy setup the output video for HDV is 1440 X 1080 60i. But when I Make a 
QuickTime movie the dimensions show 1920 X 1080. Is there something funny 
here? Or is this right.

There also seems to be some good interlacing in the video when shown could this 
be the reason?

Larry replies: Leo, thanks for the question.

http://www.larryjordan.biz/sem/2008_fall.html
http://www.larryjordan.biz/sem/2008_fall.html
http://www.larryjordan.biz/articles/lj_grfx_look.html


You have two different issues here. 

Issue 1 - HDV

HDV uses rectangular pixels to represent its image. Each pixel is short and fat, which means it 
only needs 1440 pixels to represent an entire line of HD video.

However, the computer (and some other video formats) use square pixels to represent the 
image. So, when you export from HDV to a QuickTime movie, Final Cut converts the pixels from 
rectangles to squares. Because the square pixels aren't as wide as the HDV pixels, it takes more 
of them to create the image, which is where the 1920 pixels come from. 

In other words, 1440 short, fat HDV pixels equals 1920 square computer pixels. Everything is 
operating normally.

Here's an article that might help explain this further. 

Issue 2 - Interlacing

By default, Final Cut Pro does not show interlacing; unless the image is displayed in either the 
Canvas or the Browser at 100% size. 

However, QuickTime isn't so obliging. It always displays interlacing. And, because it opens the 
image at full-size, unlike Final Cut, which tends to scale the image down in the Canvas or 
Viewer, the interlacing is all the more noticeable.

Here's the basic rule. Leave interlacing alone if you are going to DVD or broadcast. Remove 
interlacing if you are going to the web. This often means you need to create two different 
versions of your program, one with interlacing and one without.

Here's an article that can help explain interlacing further. 
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PROBLEMS WITH PAL RESETTING TO NTSC 

Paul Tait, from somewhere in Australia, writes:

Which brings up a recurring problem I have always been going to ask about but 
forgot. Without warning, during an edit session, the firewire goes haywire as FCP 
re-sets itself to 60Hz. The firewire operates for obvious reasons as it is delivering 
to a 50 Hz, deck and TV, which is the only reason I notice it immediately.

So my cure after many distressing trials is to set my capture settings to something 
else in the list like DVCPro close the program, open it again and then re-set it back 
to DV PAL 48Kz. i suspect this is something to do with FCP being designed 
around 60 Hz so it defaults back to that sometimes.

Larry replies: Paul, first the photo of six kangaroos in your back yard made me envious -- I only 
see coyotes.

http://www.larryjordan.biz/articles/lj_more_still_images.html
http://www.larryjordan.biz/articles/lj_fields.html


Second, whenever you trash or delete Final Cut preference files, FCP will reset back to NTSC 
DV 48kHz audio. My guess is that this reset happens whenever your preferences get trashed.

I don't think Final Cut inherently thinks NTSC, but that when things reset, FCP resets to its 
default settings which is NTSC.

Hope this helps.

[ Go to Top. ] 

MISSING AUDIO METERS AND TOOLBAR

Mary Lou Sheets asks:

When I was first exiting out of my project in FCP I shut down each window instead 
of exiting out of FCP after a save. When I load project back on the right side is the 
sound meter and tool bar. How do I bring them back into my project? I tried 
loading a new project but it still is missing.

Larry replies: This one is easy. Press Control+U, or select Window > Arrange > Default.

Unless you trash your preferences, Final Cut always opens your windows in the same 
configuration as when you closed the program.

[ Go to Top. ] 

RIPPING FROM A DVD

Brett, from Zaire, asks:

Quick question - my clients give me a lot of their footage on DVD. I used to use my 
old PC system to dump the footage out live then dump back to tape but I have 
since stopped using that machine and was wondering if there is any way to grab 
that footage directly from the DVD using FCP? Would I need a break out box or is 
there an application that I could use in conjunction with FCP?

Larry replies: Thanks for writing!

There are two applications I recommend, other readers may also have their own favorites:

DVDxDV -- http://www.dvdxdv.com/

MPEGStreamClip -- http://www.squared5.com/

[ Go to Top. ] 

AVOIDING CARPAL TUNNEL SYNDROME

http://www.dvdxdv.com/
http://www.squared5.com/


Frank Jonen writes:

I heard your bit about the carpal tunnel syndrome. Here is how I solved it for me 
after consulting with a few docs.

1. I got a bigger desk. The most important part is that you take the weight and 
stress off the wrists. Your elbows should sit at least like an inch away from the 
edge of the table (inwards). Shoulders should be relaxed, adjust the seat till they 
are.

Once your wrists are OK again the best thing to get is the desk. (BTW mine is 2 
IKEA curved ones put together to make a wing).

2. A Wacom tablet is good but not needed for that reason. Wacom is just to work 
faster and more naturally.

3. Strengthen your wrists. This is a pretty good Gyro trainer to do so: http://www.
dynaflexpro.com/store.php?crn=208

Personally I'm using the Gyrotwisters but just because it's a European product.

I work between 18h and 38h days and had not had any Carpal Tunnel issue in 5 
years which is when I quit at the ad agency to make it on my own. 

Larry replies: Thanks, Frank, for sharing these ideas with us.

[ Go to Top. ] 

SOUNDTRACK PRO EXPORT PROBLEM

Kimball Carr writes: 

As a long time FCP studio user, I upgraded to Leopard this year and today in 
preparing to export a 30 second multitrack commercial spot from FCP to STP I 
see my export options are 'grayed out'. A search on Apple's forums yields sparse 
results and the most helpful hint I can see is a suggested reinstall of FCP Studio 2. 
(Yikes!) So ...despite my misgivings and with a healthy dose of reliance on my 
Time Machine backup should I need to set the clock back to yesterday....I am 
reinstalling FCP Studio 2 as I type. 

I wondered if you had experienced this, or could shed some light. 

Larry replies: I wasn't sure, so I asked readers for an answer.

UPDATE - Sept. 2 

Greg Penetrante writes: 

This user doesn't have to re-install FCS. If I am reading that question correctly, 
they just have to highlight all their clips in the timeline (cmd-a) and then right click 
one of the selected clips (control click), and choose Send To > Soundtrack Pro 

http://www.dynaflexpro.com/store.php?crn=208
http://www.dynaflexpro.com/store.php?crn=208


Multitrack Project. Save the exported project as a STP project, after which STP 
will then open the Sent sequence in a new multitrack project.

Larry replies: Greg pointed out what I missed in Kimball's description -- you need to highlight 
your clips before you can send them. Thanks! 

[ Go to Top. ] 

A NEAT TRICK TO FIX FLUORESCENT FLICKER

Here's a tip that I was sent from the Final Cut Pro Yahoo List:

Question: I received some material that came to me from Finland, shot in NTSC 
HD, is showing a significant amount of fluorescent flicker. How can I fix this?

Answer: While there are a number of plug-ins you can try, here's a quick fix that 
may work fine.

What I ended up doing is using motion blur, 4 samples at 200%. In those images 
where the talent moves a lot, I have duplicated the track, used motion blur on the 
lower track, no effect on the top track and used a garbage matte to isolate the 
portion of the frame with a lot of movement. Since the flicker is isolated to the 
small section where there is a lot of motion, it isn't as noticeable as when the 
entire frame beats.

It's better than nothing and better than smeary video.

[ Go to Top. ] 

ANOTHER WAY TO COLOR CORRECT DURING A COLOR CHANGE

Recently, in the April issue of this newsletter, I wrote about how to color correct when the colors 
are changing during a shot, such as walking outdoors from indoors. (Here's the original article: 
http://www.larryjordan.biz/articles/lj_white_balancing_color_change.html).

Lee Berger sent in the following workaround that might be even faster.

Here's another approach using the Three Way CC filter. Instead of key framing, 
split the clip at the change in lighting using the razor tool. Apply the Three Way CC 
filter to each clip, color correct each as necessary. Then apply a dissolve to the 
split point. This makes it easy to shift or extend the transition point without having 
to deal with keyframes.

Larry replies: Lee, thanks for sending this in. I'll update the article.

[ Go to Top. ] 

WRAP-UP

http://www.larryjordan.biz/articles/lj_white_balancing_color_change.html


Well, that's about it for this month. 

For current news on what's happening in our industry, be sure to listen to the Digital Production 
BuZZ podcast every week.

�●     Register now for our PowerUP seminar tour - our tour will be much smaller next year. 
�●     Visit our store for our latest training videos - like Moving on Stills in FCP & Motion. 

In the meantime, please continue sending me your comments and questions. I love hearing from 
you and enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 750 KB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2008 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page or website articles are welcome and don't require prior 
permission. 

http://www.digitalproductionbuzz.com/LiveThisWeek
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http://www.larryjordan.biz/sem/2008_fall.html
http://www.larryjordan.biz/app_bin/Store/catalog/
mailto:larry@larryjordan.biz?subject=Newsletter comments
http://www.larryjordan.biz/nxltrs/ljnxltr48.pdf
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